’e‘ Materials

REGISTRATION,
DATA DOWNLOAD, AND

v SOFTWARE INSTALLATION,
A | iR
System Requirements. .......viiiin ittt ie i i E-3
Register on the Armond Dalton Resources Website........... E-4
Download the Five Initial Company Backup Files............. E-8
Registerwith Intuit . ....... ... i, E-10
*Download and Install QuickBooks Pro2020 ................ E-13
*Activate QUICKBOOKS ... ..o e E-19 .
Load the Five Company Datasets into QuickBooks Pro 2020 ... E - 25
Make Periodic Backups of Companies ...................... E-28 |
Restore Company Backup Files ......... ..., E - 31
Online Homework ...ttt e E-34
Troubleshooting. . ...t i i E-37
Uninstall the QuickBooks Pro 2020 Software ................ E-39 Y.
* SRip these steps if you are using a lab computer where QuickBooks is
previously installed.
f A




-

IMPORTANT WARNINGS...

1.

IF THE LICENSE CODE IS ALREADY REVEALED ON
THE BOOK YOU PURCHASED, RETURN THE BOOK
IMMEDIATELY TO THE BOOKSTORE AND EXCHANGE
IT FOR A NEW COPY (not applicable with E-books). You can
only access the Armond Dalton data sets homework, and Quickbooks
software with a new book containing a license code that has not been
previously used by another person.

THE QUICKBOOKS SOFTWARE AND THE INITIAL
COMPANY BACKUP FILES CAN ONLY BE LOADED ON
ONE COMPUTER, so be careful to choose the computer that
you want to use to complete the entire project.

MAC COMPUTERS ARE NOT SUPPORTED. See the
technical support section of Armond Dalton’s website for
suggestions for MAC users: www.armonddalton.com/support-
updates/mac-users/

EBOOK USERS. The Instructions book and Reference book
is included in one eBook. Any reference to a page number in
the Reference Book is a hyperlink. You can click on the page
number and you will be taken to the corresponding page of the
Reference Book.

EBOOK ACCESS EMAILS. If you purchased an eBook and do
not immediately receive the email with your access code, search your
spam/junk folder for an email from adpub@armonddalton.com.

J
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System Requirements

-

! DO NOT SKIP THIS STEP !

It is important that your computer meets the System Requirements
as set by Intuit. For the most up-to-date system requirements visit:
https://quickbooks.intuit.com/learn-support/en-us/product-system-
requirements/system-requirements-for-quickbooks-2020-and-enterprise-
solutions/00/366374

=

Note: In some cases, it may be necessary to adjust settings in these
products to ensure the best possible performance with QuickBooks. Also
note that QuickBooks will work with systems running RAID (Redundant
Array of Inexpensive Disks), but this is not recommended because
performance issues may cause QuickBooks to operate slowly.

Windows® Permission Messages

Recent versions of Windows® have more security features than older versions and
the permissions messages are one example of this increased security.

Permissions messages may appear when you are working with the software.
Whenever you receive a permissions message while attempting to complete a task
with QuickBooks Pro 2020, give Windows® permission to complete the task.

USB Flash Drive Needed for Students Doing the Project in
a Computer Laboratory or On a Network (Optional for all
other students)

If you are doing the project in a computer laboratory, where the QuickBooks
software is already installed on the hard drive of each machine, you will need to
use a USB flash drive (256 MB is large enough) for saving the data that you process.
If you are doing the project in a computer laboratory where the QuickBooks software
is installed on a network, consult your instructor about whether you should save
your data on a USB flash drive or on a designated space on the network. Even if you
have a designated space on the network for saving your data, you may still want to
back up externally to a USB flash drive as an extra precaution.
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If you are using your own computer for the project, you can do the project without
a USB flash drive. However, if you are concerned with data loss on your hard drive
and you want to back up your data externally, you will also need a USB flash drive.

Register on the Armond Dalton Resources Website

To register on the Armond Dalton Resources website (www armonddaltonresources.com),
complete the following steps:

HOME E-MATERIALS LOGIN Click Login.

U

Welcome to Armond Dalton Resources

| Emai

Password

Remember Me

LOGIN

Forgot password?

Do not have an account?

CREATE AN ACCOUNT <«—— Click Create
b an Account.

Registration

First and Last Name

Register using
— your school
email address.

youremail@yourschool.edu

Check to agree to the

termS and pOliCies. —_— [l Agree the terms and policy

I EE, ——— Click Register.

Already have an account?

LOGIN
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After your registration is complete, the Dashboard window will appear.

Homepage

ER Dashboard

Click on Profile in the upper
left corner of the window.

O Profile

0

' A

A Student Profile

nai youremail@yourcollege.edu

Mame Your First Name Your Last Name
Complete your

— registration

Phone Your Telephone Number inf ti
Information.

Address Your Address

g

- Click Update.

\ J

4 N
Colleges are listed alphabetically by proper name. If you attend University

of Alaska, you would search Alaska, Univ of. If you have selected the
correct college and you do not see your instructor listed, please email
adpub@armonddalton.com with your college and professor.

If you have more than one professor using the Armond Dalton Resources
website, you are able to add another professor. Your professors will be listed
under professors on the profile page.
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Liniversity Your College or University - Use the drop-

| _down to choose
your college and
professor.

Professor.

)

rofessor Choose the Professor g

Homepage

B2 Dashboard Click on Dashboard.

¥

O Profile

A

|—Click the down arrow on the left side of the Books box.

» Locate the QuickBooks 2020 title in the Books table. Click Verify under the
Action column.

The stickers on the front of the book are very delicate. Do not over scratch.
Scratch very gently, do not try to remove the sticker If you over scratched your
code please send us a picture of the entire sticker to adpub@armonddalton.com.
We will be able to find your code for you (not applicable with E-books).
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Verify the Book

t90q18pRAemM <

o

Click OK.

ol

Type the One-Time Use Code from
the front of your Instructions
book or from the E-book
confirmation email into the Verify
the Book box.

After entering a valid code, you will receive a message that your verification was

successful.

Verified

w
o

Click OK.

<
<

&

If the data sets and software link does not appear in the QuickBooks 2020 row of the
Books table, refresh your browser (F5 or Ctrl+R), open the Book list again and they

should appear.

[Quw(kEDDks 2020, 6th edition m nitial Company Backup Files.zip Click to go ]

4 )
Note: Your professor may choose to have you complete your homework
on this website. If so, you will receive a Section Code from your
professor to enter. This code can be entered at a later time if you have
registered before your professor has provided you with a code.

- J

» Scroll down below the Books table. You will see a box where you can enter a
Section code IF you received one from your professor.

Enter the Section
code and click Add —

Section Code.

code ADD SECTION CODE

Note: If you were provided with a section code from your instructor,
you will come back to this site later when you are ready to submit
your online homework. See page E-34 for instructions.
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Download the Five Initial Company Backup Files

The publishers have provided initial backup files for the two Intuit sample
companies, plus three other companies. The other three companies are: Jackson
Supply Company, Waren Sports Supply, and Super Office Furniture Plus. You
will want to download these files to your hard drive so you have clean copies of
all companies, should you find it necessary to start over with a specific chapter’s
requirements. You will also use the initial backup files to load the datasets into
QuickBooks.

»  Close all other open programs and temporarily disable any anti-virus
protection software and firewalls. It is very important that you follow
this step to ensure that the data sets download correctly. If you are
unsure of how to disable your anti-virus and firewall, a simple Internet
search can help.

~
Note: If you do not temporarily disable your anti-virus and firewall, YOU
WILL HAVE SOFTWARE PROBLEMS. If this happens and you contact
Armond Dalton Publishers, we will tell you that you need to uninstall and
reinstall the software with the anti-virus and firewall disabled.

J

» Create a folder on your hard drive or removable flash drive if you are
working in a computer lab called QB Backup Files.

¥ Create two sub-folders within the QB Backup Files folder that you created in
the previous step using the following names: Initial Company Backup Files and
Periodic Company Backup Files.

P Return to the Armond Dalton Resources website and click on the Initial
Company Backup Files zip files to download the provided data sets.

If you are able to select the location to download the initial company backup files,
download them to the Initial Company Backup Files sub-folder that you created.
If you are not able to choose the location, they will most likely download to your
computer’s Downloads file.

Note: When downloading, the file name will be a series of random
letters. You may choose to rename the file Initial Company Backup Files
to avoid confusion.

E-Materials: Download the Five Initial Company Backup Files
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» Extract the Initial Company Backup Files to the Initial Company Backup Files
sub-folder you just created. Follow this link for instructions on how to
extract files in Windows 10. https://support.microsoft.com/en-us/
help/4028088/windows-zip-and-unzip-files

When properly extracted, the following files should appear in the Initial Company
Backup Files folder:

I DO NOT ATTEMPT TO OPEN THESE FILES !!

RockStart.gbb
LarryStart.qbb
JacksonStart.qbb
WarenStart.gbb
SuperStart.qbb

Remember this location because you will need these files later. You will use the
backup files to load the company datasets into QuickBooks.

E-Materials: Download the Five Initial Company Backup Files
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Register with Intuit

(SRip to page E-25 if you are using a lab computer where QuickBooks is

already installed)

Intuit verifies your information through a 3rd party vendor. Please assign
verify@SheerID.com as a safe sender. Otherwise, the Intuit Verification email
may go to your spam folder. Please use your school email address. If you
use a personal email address your application may be denied.

B Click on the Intuit link below or in the Books section of the Armond Dalton
Resources website. https://www.intuit.com/partners/education-program/
products/quickbooks/student-gbdt-sighup/

Personal information -
+ First Name Your First Name
* Last Name Your Last Name
+ Email youremail@yourschool.edu
* Confirm Email Address youremail@yourschool.edu RegISter USlng
— your school
* Birth Date Jan v 1 v 2000 v H .
information.
School information
+ School Name Your School
* Major/Concentration Accounting v
* School Type 4 Year University v
+ Student Type Full-time Student v
+ Expected Graduation/Completion Date 05-2022
Select 2020 for
* QuickBooks Desktop Version 2020 — the QuickBooks
Desktop Version.
)

T

Click Verify
and Continue.

The Upload Documentation window will open.
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Upload Documentation

To complete verification, please submit any document that clearly shows your name and your specific
student affiliation.

Important - Your document must display the following:
o Your full name  XXXXXH KKK

» Your affiliation X0 OOKK

» Adate within the last 3 months

Read the
requirements — If your name or affiliation (shown above) are not correct, please click here to enter your
Carefu uy. information again.

Examples of acceptable documents are:
s Class Schedule

s Transcript

« Tuition Receipt

.

Any official document that displays your full name, college/university name, and a date within
the last 3 months

Acceptable file formats are: .bmp, .gif, jpg, .png, or .pdf.

Upload one of
the acceptable ——PCOOGOAAOOOOO XXX ®

documents.

Add another

T

Click Submit
for review.

If you do not fulfill the requirements listed you will receive an email with the
subject “Intuit Student Verification — Additional Information Needed.” Do not panic
if you receive this message. Review the acceptable document list and try again.

Once you have been verified by Intuit you will receive an email from Intuit
Verification with the subject “Intuit Education: Your QuickBooks Desktop 2020
Student Subscription.” If you don't receive this email within 20 minutes CHECK
YOUR SPAM FOLDER.

E-Materials: Register with Intuit
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INTUIT Education

Dear XXXKAXKX,

Thank you for your recent Intuit Education registration. We are pleased to provide you with
a complimantary 5-month trial of QuickBooks Desktop Accountant 2020 for Windows,
Intuit's industry-leading accounting software.

Get Started

To access your free QuickBooks Desktop Accountant 2020 software please click here to
download a exe file.

During installation/registration, when prompted please enter the License and Product
numbers.

« License Code: XOXKX-O0OK-0O0-X000
«  Product number: 3 3-3(K

Get Learning

Access our QuickBooks Desktop tutorials and leam the ins and outs of QuickBooks

MNesd a crash course in accounting? Check cut Accounting 101
Get Building

Have the next great idea? Learn what it takes to start your own business

Get Help

If you need additional help getting QuickBooks up and running, please visit the Student
Support Page and submit a requast - our team will respond back within two business days.
For lzaming support please consult your instructor or check out our lzarning page.

Follow us on Twitter
Good tuck with your coursel
Sincerely,

Imfuit Educafion

Continue in the next section to download the QuickBooks 2020 Desktop software.
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Download and Install QuickBooks Pro 2020

The software that you will download contains several educational versions of
the QuickBooks software: QuickBooks Pro (the software that is the subject of this
book), QuickBooks Accountant, and several different industry editions of QuickBooks
Premier. The way the software is designed, the user can toggle back and forth
between editions after installation. However, the default edition that opens
each time the software is opened is QuickBooks Accountant, which is virtually the
same as QuickBooks Pro. Rather than have you toggle to QuickBooks Pro each time
you open the software, which becomes tedious after several times, you should
just leave the screen at QuickBooks Accountant. For simplicity, we will refer to the
software as QuickBooks throughout the remainder of the project.

»  If you have not already done so, close all other open programs and temporarily
disable any virus protection software and firewalls.
It is very important that you follow this step to ensure that the
software installs correctly. If you are unsure of how to disable your
virus protection and firewall, a simple Internet search can help.

Note: If you do not temporarily disable your anti-virus and firewall, YOU
WILL HAVE SOFTWARE PROBLEMS. If this happens and you contact
Armond Dalton Publishers, we will tell you that you need to uninstall and
reinstall the software with the anti-virus and firewall disabled.

B If it is not already open, open the Intuit Student Verification email.

To access your free QuickBooks Desktop Accountant 2020 software please click here to
download a .exe file. A

Click the link in your email for access to the
QuickBooks Desktop Accountant 2020 software.

You will see the following file download on the bottom of your screen:

= QuickBooksPremie,..exe .
A 32.3/734 MB, 4 mins left

Double-click on QuickBooksPremier.exe.

Some systems allow you to choose where to download it. Others automatically
download it to your Downloads folder or C:\Users\"Your Name”\Downloads.
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A User Account Control warning will likely appear, saying " Do you want to allow
this app to make changes to your device.

B Click Yes, to allow the download to continue.

The InstallShield Wizard window opens.

Q! CuickBooks Financial Software 2020 R7 - InstallShield Wizard .

Welcome to the Install Shield Wizard
for QuickBooks Financial Software
2020 R7

The InstallShield Wizard(TM) will help install QuickBoaoks
Financial Software 2020 R.7 on your computer, To
continue, dick Next.

Click Next.

\/
< Back Mext = Cancel

The Extracting Files window opens.

EM QuickBooks Financial Software 2020 R6 - Insta

Extracting Files
The contents of this package are being extracted.

Please wait while the InstallShield Wizard extracts the files needed to install

QuickBooks Finandial Software 2020 R6 on your computer. This may take a few
moments,

Extracting mfc120.dl...

I

< Back Text = Cancel
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It will take several seconds to a few minutes for all of the files to extract, depending
on your computer. You do not have to do anything. When the files are done
extracting, the following QuickBooks Welcome window opens.

e
infurt
@qumkbooks.

Welcome to QuickBooks

Complete your QuickBooks installation with just a few steps. For smooth installation,
itis a good idea to close any open programs, especially virus protection programs.

Read the contents _ _ . .
of the License Once the installer is loaded, accept the license agreement to continue.

. P> view License Adgresment
Agreement window.

Accept & Continue cancel

After reading the license agreement,
click Accept and Continue.

The following License and Product Numbers window.

Intuit QuickBooks Desktop Installer

License and Product Numbers

You'll find these numkbers on your packaging orin
your confirmation email

Type the license code and
product number from the _|

Intuit Verification email
i is wi Product Number: 4
into this window. roduct Number: [ [

License Number: | | | |

@ | cantfind thase numbers

Click Next

The following window opens with the correct default selection already
entered — Express.
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Intuit QuickBooks Desktop Installer

Choose your installation type

& Express (recommended)
Install using default settings.

@ infurt
© Custom and Network options qUICkbOOkS.
Customize location and advanced server
options.
@ Explainthese choices in detail < Back @ Cancel
\
Click Next to

open the Ready
to Install window.

Intuit QuickBooks Desktop Installer

infuit
@qmckbooks.
Ready to install EPrint
Install License HOXCOKOO0OOXKK
QuickBooks Server 2020 Product OOGXXX

Location C\Program Files
HEENNtUINUIckEooks 2020

< Back m Cancel
| |

Click Install.
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@ Guiickbooks.

Do more with QuickBooks” Accountant Desktop Edition

Welcome to QuickBooks Accountant
Desktop Edition 2020

Provide more insights to your clients and save time
with powerful accountant tools.

Installing Runtime Redistributable...

[
Status

Cancel

\

It may take 15 to 20 minutes or more to install the QuickBooks program files on
your hard drive, depending on the speed of your computer and Internet. Do not
click anything while waiting for the process to complete. When the program files
have been successfully installed, the Congratulations window opens.

Intuit QuickBooks Desktop Installer
infurt
@ quickbooks.

Installation Complete

CQuickBooks has successiully installed.

Close

A

Click Open
Quickbooks.
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The QuickBooks program is now successfully installed, including the data for the
two sample companies created by Intuit.

Note: If you have issues with the installation process see Troubleshooting
on page E-37.

infut

How QuickBooks Desktop uses your Internet connection

About QuickBooks Desktop and your Internet connection

We provide a feature called "Automatic Update” which is turned on by default Automatic Update
ensures that you've gotthe latest Qui updates and in

What are my options?

Leaving Automatic Update on means that you agree to receive product updates from us automatically via
your Internet connection. If you want to learn more or turn off this feature, go to the Help menu and click
Update QuickBooks Deskiop.

What happens when QuickBooks Desktop needs to access the Internet?

QuickBooks is Web-enabled. Some features require Internet access and will open in 3 browser window. If
QuickBooks cantfind a connection, it may ask you to establish one.

For details on how Intuit respects your privacy, see the < QuickBooks Deskiop Privacy Statement

Tell me more aboutAutomatic Update

[ o Click OK.
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Activate QuickBooks

To access your 160 day trial you must activate QuickBooks Desktop.

With QuickBooks
open, click Help.

Activate
QuickBooks
Desktop.

—Ea

ol

QuickBooks Desktop Help
Ask Intuit

MNew Features

Support
Find ALocal QuickBooks Deskiop Expert

Send Feedback Online

Internet Connection Setup
New Business Checklist
Year-End Guide

Add QuickBooks Services
App CenterFind More Business Solutions

Activate QuickBooks Deskiop... k‘
Update QuickBooks Deskiop..

Manage My License

QuickBooks Desktop Privacy Statement
About Automatic Update

About QuickBooks Accountant Desktop 2020...

(o)

Activate Quickl remier: Accountant Edition 2020

IntTuit

Activate QuickBooks Desktop Now

qUICkbooks You have 30 days remaining

This is a student trial edition of QuickBooks Premier:

Accountant Edition 2020.

After registering, this product will expire in 160 days.

You can also buy and unlock the full edition of QuickBooks

Premier: Accountant Edition 2020.

To find out more, go to Help->Buy QuickBooks after you have

activated the product.

Remind Me Later

E-Materials: Activate QuickBooks
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INTUIT
@ turbotax @ quickbooks @ mint

Sign In

Sign in to your account to activate QuickBooks
Deskiop Learn more.

Email or user ID

Password

Remember me

& Signin

By clicking Sign in, you agree to our
Terms and have read and acknowledge our US Privacy
Statement.
Updated on January 1, 2020

| forgot my user |D or password

Click Create

[NEW to Intuit? Create an accou I'I1.| [ anaccount.

The Create Customer Account window opens.
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Learm more.

Email address

email@youremail.com

First name

Your First Mame

Last name

Y¥our Last Mame

Phone (recommended)

(555) 555-5555

Standarnd call, messaging of dala rales may apply

Remove the check
mark next to Verify ———> Verify with text message
with text message.

Pas=zword

Confirm password

One Account.
Everything Intuit.

ﬂ turbotax @ quickbooks ﬁ} mint

Create an account to activate QuickBooks Deskiop

ol

<,

<,

Enter your email address,
— first and last name, choose
a password, then retype to
confirm your password.

e Create Account

—— Click Create Account.

J
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Note: If you did not print out the E-materials, write your username and
password somewhere in your Instructions book for future reference. If you
printed out the E-materials, record your username and password here.

Write your User ID here for future reference. Write your Password here for future reference.
- J

Create Customer Account

Looks like there are no customer accounts added to this profile (jobs@armonddalton.com). Let's start with creating a
customer account. The customer account will include your company information and primary contact details. Note that
your product license will be activated and linked to this account.

Create Account.

\
|
|

Create an account

Want to activate QuickBooks with a new account? Create an account

User: jobs@armonddalton.com | Change User

The registration/activation window opens for you to begin entering other
registration information.

E-Materials: Activate QuickBooks
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Use your name, address,
and telephone number for
the company information
and primary contact.

Create Customer Account

fiCiear Aii Fields}

COMPANY INFOMTIBLION: r0iirimiinuninnesinnsarsneisasnissorassssnssssnss sentessenssssssssst scassssanssasassssasuasses st dos vassasanes

* Country:

= Company name:

* Address 1
Address 2

“City

* State:

* Zip / Postal code:

* Business phone:

Business fax

United States

Your Name

Your Address

Your City

M

45864

000 000

0000  ext

PrIMATY COMACE 1xsooseinassarnnsssoissssnnssss sossssnnssnonssiastossssss dsassasis bisbsitnet ssanss siessastnas ssbssinnisniassunserssoniis

* First name:

* Last name

Job fitle:

*Work phone:

Home phone:
Cell phone:

* Email address

Your First Name
Your Last Name
- Select Job Tifle -

000 000 0000

ext.

youremail@yauremail.com

Tell us about your company(Optional):

*Required fields

Cancel

Click the drop-
| down next to

E-Materials: Activate QuickBooks
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Tell us about your company(Optional): ...eoeeismeisiionimiiisinaninniiineissneicssnissssssssisiasess.

4. Is this your company’s first version of QuickBooks Desktop? @J Yes C‘ Mo

2. Industry:
Other [v]
Com plete all Of the 3. Where did you get this copy of QuickBooks Desktop?
information Shown in Onling from QuickBooks com or Intuit.com E
. . . 4, Number of full & part-time employees on your payroll?
this window using the — e Kl

guidance below when e —
completing the form.

a. Accept credit cards?

Mo M
b. Print checks?
Yes E‘
c. Use a payroll service or payroll software?
Yes ﬂ
*Required fields Calier] m_ CliCk Next.

= Choose “Yes” to Is this your company’s first version of
QuickBooks.

= Choose “Other” as the Industry.

= You obtained your copy of QuickBooks from Online from
QuickBooks.com or Intuit.com.

= Use the “more than 50” option for the number of employees.

= No, your company does not accept credit cards.

= Yes, your company prints checks.

|

Yes, your company will use QuickBooks to prepare payroll.

You will then receive a registration confirmation window with your registration
information. If you do not receive a confirmation window, scroll to the top of the
screen to see if there are any errors listed in red at the top of the page.

B> Take a screen shot of your registration confirmation window and save it to a
location on your computer where you will remember it in case you need it for
future use.

» Close the confirmation window.
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Load the Five Company Datasets into
QuickBooks Pro 2020

As mentioned on page E-8, the publisher has provided data that you will need to

load in QuickBooks Pro 2020 to complete this project.

B> Open QuickBooks, if it is not already open.

Click File.
Mew Company...
. Mew Company from Existing Company File..
Click Open or 0 — _—
Restore Company. LUpen or Kestore L-ompany...

Open Previous Company

B You will receive a warning that you have 160 day left to use QuickBooks.

Click OK.

Open or Restore Company

What type of file do you want to open or restore?

el A ) Open a company file
= |
- * Open a regular company file (.gbw)

= Open an Accountant's Copy working file {.gba)

(® Restore a backup copy
+ Restore a backup file (.qbb) <

= Restore files from an online backup

g ) Restore a portable file
» Re-create a company file that was stored as a portable file {.gbm)

) Convert an Accountant's Copy Transfer File
= Select an Accountant's Copy Transfer File ((QBX)
» Convert itto an Accountants Copy working file( QBA) and save it

Click Next. — Next Einish Help

Cancel

E-Materials: Load the Five Company Datasets into QuickBooks Pro 2020
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Open or Restore Company

Is the backup copy stored locally or online?
Select the Local
Backup button if it is —
not already selected HBackup copy is saved on this computer, on a remaovable storage device, or on a

network drive

7 Online backup

bl

Backup copy is stored online.

Click Next. _m e Help Cancel

The following window opens, but the contents of the Look in box may vary
depending on what you selected during the most recent backup process. The

location will most likely be the Initial Company Backup Files subfolder you created
earlier in the chapter.

Open Backup Copy

Look in: | initial_co_backup_files - e ? =4 V
~
S Name Date modified Type
Locate and select the :
— - Jacksen Start 5/4/2020 10:08 AM Cuicl
JacksonStart backup file. Quickaccess o8| oo Start 5/4/2020 10:02 AM Quich
- Eﬁj Rock Start 5/4/2020 10:08 AM Quick
[53 Super Start 5/4/2020 10:08 AM Cuick
Desktap (50 Waren Start 5/4/2020 10:08 AM Quich
-
m
Libraries
This PC
@ el ] >
Metwork — —
File name: “.GBB > Open
Fies oftype: | QBW Backup (~QEB) -
! e — . |

Note that if you are restoring from a USB flash drive, you will need to change the
contents of the Look in box accordingly. The following window opens.
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Where do you want to restore the file?

In the next window, you will choose the location where you want to restore the file. As the
= file restores, it is converted to a company file with the extension .gbw.

Important: If you don't want to overwrite your existing company file, rename the file in the
next window. For example, you may want to add a date or version number such as
mycompanyname-Jan2-2007.qbw or mycompanyname-v2.qbw.

CliCk Next. ——Bat!—»m Finish Help Cancel

The following window opens. Make sure the location is C:\Users\Public\
Public Documents\Intuit\QuickBooks\Sample Company Files\QuickBooks 2020.
Don’t be concerned if the contents of your window differ slightly.

Save Company File as

Save in: QuickBooks 2020 - e 7 e Er
~
* MName Date modified Type
. sample_product-based business.qgbw.Search... 5/4/2020 12:33 PM File fo
Quickiatcess sample_service-based business.qbw.Searchl.,  5/4/2020 12:34 PM File fe
- sample_product—based business 5/4/202012:33 PM Cuich
sample_ser\.rice-hased business 5/4/2020112:37 PM Quick
Desktop
MM
Libraries
This PC
E@ - C— >
Network — —_— .
File name: Jackson Supply Comparny - Save ﬂ' — ClICk Save.
Save as type: Guick Books Files (" GBW) -
Help
"

» Repeat this procedure for the four remaining company backup files. Note:
Jackson Supply, Super Office Furniture Plus, and Waren Sports Supply
may prompt you for a password. If so, use Adminl111. The first time
after restoring, Larry's Landscaping and Rock Castle Construction will
ask you for your user name and password that you created on page E-21.

B You will receive a message the QuickBook Desktop needs to update your
company file. Click Yes to continue.

» You will then receive a message that you are opening a QuickBooks Desktop
sample file. Click OK.
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Make Periodic Backups of Companies

It is not mandatory that you back up your data files because posted transactions are
automatically saved on your hard drive. However, it is recommended that you back up
the data files each time you complete a work session or chapter. You will need to use
these backup files only if you wish to redo part of the project but not other parts.

QuickBooks has a built-in backup feature in the software. This is a helpful feature

if you are using your own computer to complete the project and do not need to
move to another computer. It is recommended that you back up your files after
each graded chapter and name the backup files accordingly so that you know which
backup to use if you have to start a chapter over again.

When making a backup of a company, be sure to give the backup file a descriptive
name, such as “Waren Ch 9 After Transaction 10,” so that you can easily locate the
proper backup if you need to at a later time.

If you are concerned about possible loss of data on your hard drive and want to back
up your data externally to a USB flash drive, choose your USB flash drive as the
destination for backups instead of the QB Backup Files folder on your hard drive.

To back up a file, open the QuickBooks program and open the company for which
you want to prepare a backup file.

» Click File > Back Up Company = Create Local Backup to open the following
window.

Create Backup

Make a backup copy of everything you need to recreate your company file in case of
% accidental loss or damage to your data.

Do you want to save your backup copy online or locally?

) Online backup

Get automatic, online backup for your QuickBooks data and other important
documents using Intuit's online backup solution (fees may apply).

Try now or learn more

Select Local
Backup if it is not
already selected.

\§é\'}'é"I'Hé'é'i'l'ﬁh a removable storage device (such as a CD or USB flash drive)
or to a folder on your network.

Options Click Options to change your current backup settings.

Click Next to get
the following

Backup Options _m Einish Help Cancel

window.
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If necessary, remove the check
mark in the box next to “Limit

the number of backup Copies In —— >~ Addthe date and time of the backup to the file name (recommended)

this folder to,” so that the box is
unchecked before continuing.

Click OK. —@ Cancel Help

Lse this window to set default options for your manual and automatic backups.

LOCAL BACKUP ONLY

Tell us where to save your backup copies (required)

Browse... <

gLimit the number of backup copies in this folder to

ONLINE AND LOCAL BACKUP

¥ Remind me to back up when | close my company file every 4 times.

Select an option to verify that your company data is OK (that is, not corrupted) when
you save.

® Complete verification (recommended)

" Quicker verification

7 Mo verification Help me choose

ol

Use the Browse button
to select the Periodic
Company Backup Files

— sub-folder on your
hard drive that you
created earlier and
then click OK.

If you chose to save the backup to your hard drive you will receive a message giving you
the option to change the location of use the location on the hard drive. Either option is
appropriate. After choosing where to save the backup the following window will open.

Create Backup

Select the Save it now radio
button if it is not already ___
selected.

Click Next.

When do you want to save your backup copy?
’“;Save itnuwi
7 Save it now and schedule future backups

7 Only schedule future backups

Mote: If you are saving your backup copy to a removable storage device such as a CD
or USB flash drive, insert the CD or connect the device now.

—e v || cance

The following window opens. Note that the default location will be either the QB
Backup Files folder on your hard drive or your USB flash drive, depending on what
you did in previous steps.
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Select the Periodic
Backup Files
sub-folder.

Give the backup file a
descriptive name in the
File name box, such as
“Waren after Ch 07.

Cuick access

Desktop

m
Libraries

>

This PC

@

>

Mame

- Periodic Company Backup Files [+] @ ?

.

Mo iterns match your search,

* [~

Date medified

4 C—

Eil

- Waren After Ch 07

Metwork

Save astype:

GBW Backup (*.QBB)

-
-

Type

Save

Help

— Click Save.

The program will take a few seconds to perform the backup procedure. When
complete, you will receive a message telling you that the backup file was created
and where it was stored.

»  Click OK.
» Repeat the backup procedures for each company you wish to back up.
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Restore Company Backup Files

If you decide to redo a portion of the project, you can restore your data files

using either the initial backup files from the Initial Company Backup Files you
downloaded earlier or any of the periodic backup files you create while completing
assignments in this book.

In addition to a built-in backup procedure, QuickBooks has a restore feature built
into the program. This is a helpful feature if you are using your own computer

to complete the project and do not need to move to another computer. If you've
backed up your files frequently and labeled them specifically enough, you should be
able to restore any and all companies at any point in the project.

- Open QuickBooks and the company you want to restore.
B Click File, then Open or Restore Company. The following window opens.

Open or Restore Company

What type of file do you want to open or restore?

" Open a company file
Clle the :Open a regular company file (.qb\_nr)

Open an Accountant's Copy working file (.qba)
Restore a

backup copy 5Hle (qbb)
radio button. +Restore files from an online backup
% 7 Restore a portable file

+Re-create a company file that was stored as a portable file (.gbm)

3 Convert an Accountant's Copy Transfer File
+ Select an Accountant's Copy Transfer File (QBX)
+ Convertitto an Accountant's Copy working file{.QBA) and save it

Click Next. ——Brrl—.m Finish Help Cancel

u J

The following window opens.

Open or Restore Company

Is the backup copy stored locally or online?

Select the Local
Backup button if it is —]
not already selected. Backup cupy is saved on this computer, on a removable storage device, orona

network drive
1 Online backup

Backup copy is stored online.

Click Next. —] m Finish Help Cancel
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The following window opens, but the contents of the Look in box may vary
depending on what you selected during the most recent backup process. The
location will most likely be in a sub folder of the QB Backup Files folder you
created earlier in the chapter.

Open Backup Copy

Look in: Initial Company Backup Files = & ? w "
* B Date modified Type Locate and select
_ ﬁj]ackson Start 6/23/2020%:03 PM  QuickBoo the backup file you
Quick access o8| 2 Start 6/23/20209:03PM  QuickBoo | | _ want to use to
- ﬁj Rock Start 6/23/20209:03 PM  QuickBoo restore the
ﬁj Super Start 6/23/20209:03 PM  QuickBoo company’s dataset.
Desktop 1 Waren Start 6/23/2020 %03 PM  QuickBoo
m
Libraries
This PC
A 3 * '
" i : File name: Lamy Start - _ Click Open.
etwor e
Rles of type: QBW Backup (* GEB) -
L Help

Select the backup file carefully. For example, if you’re starting from scratch, select
the initial company backup file (RockStart, LarryStart, etc.). Note that if you

are restoring from a USB flash drive, you will need to change the contents of the
Look in box accordingly. The following window opens.

Open or Restore Company

Where do you want to restore the file?

In the next window, you will choose the location where you want to restore the file. As the
= file restores, itis converted to a company file with the extension .gbw.

Important: If you dont want to overwrite your existing company file, rename the file in the
next window. For example, you may want to add a date or version number such as
mycompanyname-Jan2-2007.gbw or mycompanyname-v2.gbw.

Click Next. ——am_\—“ Finish Help Cancel
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The following window opens. Make sure the location is

C:\Users\Public\Public Documents\Intuit\QuickBooks\Sample Company Files\
QuickBooks 2020. Don’t be concerned if the contents of your window differ
slightly.

Save Company File as

Savdin: TQuickBooks 2020 v @ ? e [~
* MName & Date modified Type —
: Restored_WarenStart_Files 6/23/2020 9:17 PM File fol
Quick access Sample_Company_ File - Images 6/23/2020 829 PM  File foll
- sample_product-based business.qbw.Search... 6/23/2020 %:14 PM File fol:
SEIECt the Company over sample_service-based business.qbw.Searchl... 6/23/2020 9:12 PM File fal
which you want to restore TEEkTop | SuperQfficePlus best guess.qbw.Searchindex  6/23/2020 %16 PM  File fols
. Waren5tart.OBW.5earchindex 6/23/2020 9:17 PM File foli
™M Jackson Supply Company 6/23/20209:10 PM  QuickB
Libraries sample_product-based business 6/23/2020 9:41 PM  QuickB
sample_service-based business 6/23/2020 9:42 PM  QuickB
l—"_ SuperOf‘ficePIus best guess 6/23/2020 9:45 PM  QuickB
Thiz PC WarenStart 6/23/2020 9:40 PM  QuickB &
p | >
. i 5 File name: sample_service-based business -]
etwor —
Save as type: QuickBooks Files (*QBW) w7
Help

You will receive a warning message asking if you want to overwrite the company data.

Confirm Save As

sample_service-based business.gbw already exists.
Do you want to replace it?

Yes < JI { K53 ] J Click Yes.

Delete Entire File

Caution! You are about to permanently delete this
data file. Are you sure?

Type YES to confirm. |

Click OK.

Cancel

Type "YES."

Click OK when you are told that the file restored successfully.

Repeat the restore procedures for each company you wish to restore. Note that
in order to restore a specific company that already exists in QuickBooks,
that company has to be the one opened in QuickBooks during the
restore process.
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Online Homework

When you are ready to submit your online homework, you will log in to the
Armond Dalton Resources website at www.armonddaltonresources.com, using the
username and password you created on your first visit to the site. If you have not
already done so, enter the section code that was provided to you by your instructor.
See page E-7 for reference. Locate the QuickBooks 2020, 6th activity/activities in
the Section box on the Dashboard page. The activity start date/time and end date/
time are listed on the table. If your professor assigns an activity for Chapter 9, the
alternative transactions list that you will need is located in this table.

A sections

SHOW 100ROWS ~ [BICSV  REXCEL
- rnative

Acct 300 QuickBooks 2020, 6th Mon-Wed 10:00 Chapter 2 05-28-2020 07:46 06-12-2020 07:46 Fall Download o
edition Transactions/Price

Your professor may assign multiple activities to be completed over the course of the
semester. If this is the case, each activity will be listed in the table.

( sectons )
Book Section Start End [ ‘Semester

Mon-Wed 10:00 Chapter4 06262020 07:51 07102020 07:51 Fal

e = 4T Click the drop-

“ o a. down arrow on the
craprr = button under the

\ — ) Action column.

Mon-Wed 10:00 Chapter3 06122020 07:50 06-26-2020 07:51

B Click Activity Overview.

Book Activity: QB Homework Lnd
#* Worksheet Points Earned Points Possible Status
Total 0 0
ENTER ANSWERS

Click "Enter Anwsers."
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Choose Chapter o CliCk the dl’Op-
down arrow to
see the available
chapters.

Select Chapter ¥

Choose Chapter A

Select Chapter

Select Chapter
Chapter 2 - Familiization

Chapter 3 - Overvidw of Maintenance, Processing Information, and Internal Controls

Chapter 4 - Obtainjng Information from QuickBooks, Including Reports

Chapter 6 - Practicf: Purchases and Cash Disbursements Cycle Activities

Chapter 7 - Practic: Sales and Cash Receipts Cycle Activities

Chapter 8- Practicf: Payroll Cycle and Other Activities

Chapter 9 - (Warer|Sports Supply): Recording Transactions, Performing Month-End Procedures, Recording Year-End Adjusting Entries, and Printing Reports

Chapter 10 - New qompany Setup

Choose the chapter for
which you are submitting
your answers.

Your professor may assign two parts of homework for each chapter. To access the
other part, click on the tab below the chapter name in the Choose Chapter box.

Part | - Questions

You can save, exit, and return at any point without submitting final answers by
clicking on the “Save Homework” button located at the top and bottom of each
page. You can submit the homeworks for Part I and Part II of a chapter separately
by clicking the “Submit Homework” button in each part. You can also submit the
parts at one time by clicking the “Submit All Homework” button in Part II of the
chapter homework.

If you are required to submit more than 1 upload, you will need to zip the files
together to upload them as one compressed file.
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With a homework activity that contains multiple chapters, you will submit each
chapter individually. You can submit a part of homework without completing all

questions/problems. You will not receive points for the question/problem. If you do
so, you will receive the following warning message:

Warning

Not all requirements have been completed in this part. Do
you still want to submit?

— Click Submit anyway.

With each submission the screen will display the points earned and possible for the
part of homework. Some answers need to be reviewed by the instructor before the

points earned will be displayed. These submissions will say “Not Graded” until the
review has been done.

( )

Chapter 2 Homework STUDENT INSTRUCTIONS
Book Activity: Chapter 2 Homework o

#  Worksheet Points Earned Points Possible Status

1 Chapter 2 - Familiarization, Part | - Questions 24 34 Automated

2 Chapter 2 - Familiarization, Part Il - Problems 0 16 Not Graded

Total 24 50
ENTER ANSWERS

Once the submission has been reviewed by your professor, it will say “Graded”
and your score will be displayed. You can return to view your score by locating the
activity in the Sections table of the Dashboard, clicking the drop down arrow on
the button under the Action column, and clicking Activity Overview.
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Troubleshooti NE (Not Applicable for Lab Computer Users)

You may receive the following installation error window.

Intuit QuickBooks Desktop Installer

O We're sorry! Something went wrong with your installation.

Error 1904 Module "C:\Program Files (x86)MntuitCiuickBooks
2020MCWrapper.dll” failed to register,

W Send error report to Intuit

Troubleshoot error Close

Click Troubleshoot error.

() QuickBooks Tool Hub

nfurt

ab quickbooks.

Home
Company File Issues
Network Issues
Program Problems

Click
Installation —®installation Issues

issues.
Password Reset

Help & Support

Advanced Tools

QuickBooks Tool Hub

Welcome to the QuickBooks Tool Hub!

A T-stop shop for all your QuickBooks Troubleshooting Needs... Windows 10 recommended for Tool Hub use
Company File Issues: Runs the QuickBooks File Doctor to repair common data file problems.
Network Issues: Solve common networking errors such as H202.

Program Problems : Resclve common problems opening or working in your QuickBooks version by
repairing all the required Microsoft components. Additionally, you can fix PDF and Print issues.

Installation Issues: This will fix common problems cpening or working in your QuickBooks version by
repairing all the required Microsoft components. You can also use the 3371 error fix.

Password Reset: Run the automated password reset tool to reset your admin password,
Support: Get help if the Tool Hub fails to solve your problem and connect with an agent faster.
Advanced Tools: This is for more advanced users which has shortcuts to many common tasks.

About / What's New Installed Version is 1.4.0.0- Check for Updates
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Click
QuickBooks
Install
Diagnostic Tool.

After running the QuickBooks install diagnostic tool, reboot your computer and

@) QuickBooks Tool Hub

nfurt

ab quickbooks.

Home

Company File Issues

Network Issues

QuickBooks Tool Hub

Fix My Installation Issues

1) First, try running the QuickBooks Install Diagnostic Repair tool. This will attempt to fix
commeon issues preventing you from installing QuickBooks Desktop and the QuickBooks Online
Windows App. ~ 10 minutes to complete

Program Problems

Installation Issues

Password Reset

Help & Support

Advanced Tools

2) If you are getting a 3371 error opening any version of QuickBooks Desktop, you will need to
use the 3371 error fix. The 3371 fix should only be used if you are receiving error 3371 when
opening QuickBooks Desktop. Impeortant: Running the 3371 fix will reset your QuickBooks
Desktop registration status in all installed versions, you will need to re-register them after using
the 3371 fix. This is required to fix error 3371, which is why you should only use this tool to fix
3371 errors.

Download QuickBooks Desktop Check for Windows Updates

start again with the installation process on page E-13

If you run the diagnostic tool and are still having problems, you can chat with a

QuickBooks representative at:

https://help.quickbooks.intuit.com/prechats/offerings/QB-Desktop-ProPremier-
CHAT/22240/view
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Uninstall the QuickBooks Pro 2020 Software

(Not Applicable for Lab Computer Users)

When you have completely finished the project and have handed in all required
assignments to your instructor, you are likely to want to remove the QuickBooks
program files and sample company datasets from your hard drive. Your company
backup files remain on your hard drive in the QB Backup Files folder.

B Open Control Panel.
B Locate and select QuickBooks and remove the program using the method
dictated by your operating system.

» Manually remove the QuickBooks folder from the location where the program
initially installed. (C:\Users\Public\Public Documents\Intuit for most
operating systems). The location may vary with different Windows®
operating systems.

There may also be some leftover files to delete in the following location:
C:\Program Files\Intuit.

For some operating systems, that location is:
C:\Program Files (x86)\Intuit.
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